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Résumé— L'accès à l'eau potable reste un défi majeur dans les zones rurales de la République Démocratique du Congo (RDC), où les 
communautés dépendent de sources d'eau naturelles non protégées. Cette étude vise à identifier les sites propices à l’implantation de 
forages en utilisant les Systèmes d’Information Géographique (SIG), la télédétection et l’Analyse Multicritère (AMC) afin d'améliorer la 
gestion des ressources en eau dans la région de Ngoyo-Mununzi, au Nord-Kivu. 
Une combinaison de SIG, de télédétection et du Processus Hiérarchique Analytique (AHP) a été utilisée pour évaluer les facteurs 
environnementaux clés influençant la disponibilité des eaux souterraines. Les paramètres analysés incluent la pente, la densité de 
drainage, la géologie, l’occupation du sol, la précipitation, la texture du sol et l’indice de végétation (NDVI). La méthode AHP a permis 
de pondérer ces critères, et une analyse spatiale a été réalisée avec ArcGIS et Google Earth Engine (GEE) pour générer une carte du 
potentiel en eaux souterraines. 
Les résultats montrent que les zones à faible pente, à densité de drainage modérée et aux formations géologiques perméables sont les plus 
adaptées à l’implantation de forages. La carte finale classe la zone d’étude en cinq catégories de potentiel, allant de faible à excellent. Les 
zones les plus favorables se situent principalement au sud et au nord-ouest de la région. 
Cette étude démontre que l’approche combinant SIG et AMC basée sur l’AHP permet d’identifier efficacement les sites optimaux pour 
les forages, offrant ainsi une solution économique pour améliorer l’accès à l’eau en milieu rural.  

Mots clés— Télédétection ; Analyse multicritère ; Hydrogéologie ; SIG ; Recharge des nappes ; Sélection de sites ; Modélisation spatiale ; 
Gestion de l’eau. 
 

Abstract— Access to drinking water remains a major challenge in rural areas of the Democratic Republic of Congo, where communities 
rely on unprotected natural water sources. This study aims to identify suitable locations for boreholes using Geographic Information 
Systems (GIS), remote sensing, and Multi-Criteria Decision Analysis (MCDA) to enhance water resource management in Ngoyo-
Mununzi, North Kivu. 
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A combination of GIS, remote sensing, and the Analytical Hierarchy Process (AHP) was employed to evaluate key environmental factors 
influencing groundwater availability. Parameters such as slope, drainage density, geology, land use, precipitation, soil texture, and 
vegetation index (NDVI) were analyzed. The AHP method was applied to weight these criteria, and spatial analysis was conducted using 
ArcGIS and Google Earth Engine (GEE) to generate a groundwater potential map. 
The results indicate that areas with low slopes, moderate drainage density, and permeable geological formations are the most suitable for 
borehole installation. The final groundwater potential map classifies the study area into five categories, ranging from low to excellent 
suitability. Zones with high suitability cover a significant portion of the region, particularly in the southern and northwestern parts. 
This study demonstrates that GIS and AHP-based MCDA can effectively identify optimal sites for boreholes, providing a cost-effective 
approach to improving water access in remote areas.  

Keywords— Remote sensing, Multi-criteria analysis, Hydrogeology, GIS, Groundwater recharge, Site selection, spatial modeling, Water 
management 

 

 

I. INTRODUCTION 

I.1. Contexte et justification de l’étude 

L’accès à l’eau potable est un défi majeur dans les zones rurales de la République Démocratique du Congo (RDC), où une grande 
partie de la population dépend encore des sources d’eau naturelles souvent non protégées [1]. La pollution des eaux de surface, la 
variabilité climatique et l’absence d’infrastructures de distribution d’eau exacerbent cette problématique, entraînant des risques 
sanitaires élevés pour les populations locales. Dans ce contexte, l’exploitation des eaux souterraines à travers le forage de puits 
constitue une solution durable pour l’approvisionnement en eau potable, notamment dans des régions où les sources de surface sont 
rares ou contaminées [2]. 

Cependant, l’implantation de forages nécessite une sélection rigoureuse des sites afin d’optimiser la rentabilité des opérations et 
d’assurer la durabilité des ressources exploitées [3]. Les méthodes conventionnelles de reconnaissance hydrogéologique, bien que 
précises, sont coûteuses et nécessitent des investigations de terrain approfondies [4]. Dans ce contexte, l’utilisation des Systèmes 
d’Information Géographique (SIG) et de la télédétection combinée à une analyse multicritère apparaît comme une approche innovante 
et efficace pour identifier les sites propices à l’installation de forages d’eau potable [5]. 

En effet, la télédétection permet d’analyser plusieurs paramètres environnementaux influençant la recharge et la disponibilité des 
eaux souterraines, tels que la pente, la densité de drainage, la géologie, l’occupation du sol, la pluviométrie et la texture du sol [6]. 
L’Analyse Hiérarchique des Processus (AHP) permet, quant à elle, de pondérer ces différents facteurs en fonction de leur importance 
relative dans le processus de sélection des sites de forage [7]. 

La présente étude s’intéresse à la région de Ngoyo - Mununzi, située au Nord-Kivu, en RDC. Cette région fait face à des défis 
d’accès à l’eau potable en raison de sa topographie variée, de la densité du réseau hydrographique et des caractéristiques géologiques 
locales. L’objectif est d’identifier les sites potentiellement favorables à la mise en place de forages en combinant les outils de 
télédétection, d’analyse multicritère et de SIG. 

I.2. Objectifs de l’étude 

L’objectif principal de cette étude est d’identifier les zones favorables à l’installation de forages d’eau potable en zone rurale à 
l’aide des SIG, de la télédétection et de l’analyse multicritère. Plusieurs objectifs spécifiques découlent de cet objectif général : 

 Analyser les paramètres environnementaux influençant la disponibilité des eaux souterraines à l’échelle de la zone 
d’étude. 

 Appliquer la méthode AHP pour la pondération des critères utilisés dans la sélection des sites. 

 Élaborer une carte de potentiel des sites favorables à la mise en place de forages. 
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II. RÉVUE DE LITTÉRATURE 

II.1. Introduction 

L'identification des zones potentielles d'eaux souterraines est essentielle pour la gestion durable des ressources en eau. Les 
Systèmes d'Information Géographique (SIG) couplés au processus de hiérarchie analytique (AHP) sont couramment utilisés pour 
délimiter ces zones. Cette revue analyse plusieurs études en tenant compte des critères d'évaluation, des méthodes employées et des 
limites observées. 

II.2. Applications du SIG et de l'AHP dans l'identification des zones potentielles d'eaux souterraines 

II.2.1 Méthodologies et critères d'évaluation 

Les études examinées adoptent une approche multicritères, combinant différents paramètres influençant la recharge des nappes : 

 Géologie et lithologie : facteurs majeurs influençant la porosité et la perméabilité [8], [9]. 

 Géomorphologie : étudiée pour identifier les formations favorisant l'infiltration [10], [11]. 

 Pente et altitude : impactent la vitesse d'écoulement et l'accumulation d'eau [12], [13]. 

 Densité de drainage et linéaments : utilisée pour déterminer la connectivité et la recharge des nappes [14], [15]. 

 Utilisation des terres et couverture végétale : reflète l'impact anthropique sur l'infiltration ([16] ; [17]). 

 Précipitations : considérées comme une source primordiale de recharge ([18] ; [8]). 

II.2.2 Comparaison des résultats 

Les études montrent que la combinaison SIG-AHP offre une classification efficace des zones de recharge, validée par des données 
de terrain. Toutefois, certaines limites persistent : 

 Subjectivité des pondérations : bien que l'AHP permette une pondération structurée, il reste influencé par l'expertise des 
chercheurs [12]. 

 Disponibilité et qualité des données : un accès limité aux données sur la perméabilité et l'épaisseur des formations altérées 
peut affecter la précision des modèles [14], [19]. 

 Validation des modèles : plusieurs études déplorent le manque de vérification sur le terrain des résultats obtenus [10] ; 
[13]. 

II.3. Approche dans les zones tropicales humides et équatoriales 

Contrairement aux régions arides, les zones tropicales humides présentent des défis particuliers en raison de la forte variabilité 
climatique et des terrains souvent instables. Plusieurs études [20], [21], [22] montrent que dans ces environnements, la profondeur 
de la nappe phréatique est rarement un critère pertinent en raison de sa variabilité temporelle et spatiale. 

II.3.1 Spécificités des critères 

Dans ces zones, la recharge dépend davantage : 

 De la couverture végétale et de l'utilisation des terres ([23] ; [24]). 

 De la topographie et de la pente ([25] ; [26]). 

 De la densité de drainage et du type de sol ([27] ; [28]). 

L'approche SIG-AHP reste efficace mais requiert des adaptations pour refléter les spécificités locales. 
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II.4. Cas d'étude en RDC 

L'étude de Sanga et al. (2017) dans les Hauts Plateaux de l'Est de la RDC illustre l'application du SIG et de l'AHP dans un contexte 
équatorial. Elle met en avant les facteurs suivants : 

 Topographie complexe influençant l'infiltration. 

 Régime climatique avec précipitations abondantes, mais irrégulières. 

 Dépendance des communautés locales aux eaux souterraines pour l'agriculture et l'approvisionnement en eau potable. 

Malgré ses contributions, l'étude présente des limites, notamment l'absence de données précises sur la profondeur des nappes et des 
validations de terrain insuffisantes. 

II.5. Conclusion 

L'utilisation combinée des SIG et de l'AHP s'avère efficace pour délimiter les zones à fort potentiel en eaux souterraines. Toutefois, 
plusieurs défis subsistent, notamment la subjectivité des pondérations, la qualité des données disponibles et la validation des 
résultats. Les zones tropicales humides nécessitent une adaptation des critères d'évaluation, notamment en réduisant l'importance 
de la profondeur de la nappe au profit d'autres paramètres tels que la couverture végétale et la topographie. 

L'étude de cas en RDC met en évidence ces spécificités et suggère la nécessité de développer des méthodes plus adaptées aux 
conditions locales pour améliorer la précision des prédictions et la gestion des ressources en eau souterraine. 

III. MATÉRIEL ET MÉTHODOLOGIE 

III.1. Localisation de la zone d’étude 

La zone d’étude est localisée dans la province du Nord Kivu, en République Démocratique du Congo (RDC), dans le Territoire 
de Beni. Elle est située à environ 15 kilomètres au Nord-Ouest de la Ville de Beni. Elle consiste en une délimitation rectangulaire de 
35 kilomètres carrés avec sept kilomètres de longueur sur l’axe des latitudes et cinq kilomètres de largeur sur l’axe des longitudes. 

Elle comprend et inclus : La localité de Ngoyo au Sud ; La localité de Mununzi au Nord ; Ainsi que toutes les différentes 
agglomérations situées sur l’axe Mununzi-Ngoyo ; Et une partie des agglomérations situées sur l’axe Ngoyo-Kalibo vers l’Est. 
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Figure 1. Localisation de la Zone d'étude 

III.2. Données utilisées 

L'étude repose sur plusieurs sources de données essentielles, traitées et analysées à l'aide de Google Earth Engine (GEE). Ces 
données couvrent divers aspects environnementaux et géotechniques et sont issues de bases de données réputées et validées 
scientifiquement. 

a) Modèle Numérique de Terrain (MNT) 

Nous avons utilisé le Modèle Numérique de Terrain Shuttle Radar Topography Mission (SRTM), fourni par l'USGS sous la 
référence USGS/SRTMGL1_003. Ce MNT, avec une résolution spatiale d'environ 30 m, permet d'extraire des paramètres 
topographiques comme la pente et la densité de drainage [29]. 

b) Occupation du sol 

L'occupation du sol est issue du produit Dynamic World (GOOGLE/DYNAMICWORLD/V1), qui fournit une classification à 
haute résolution basée sur Sentinel-2, mise à jour en temps quasi-réel. Cet ensemble de données a été filtré sur la période allant 
d'octobre 2022 à septembre 2023 afin de capturer une vision globale des dynamiques d'occupation du sol durant l'année hydrologique 
considérée [30]. 
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c) Géologie 

Les données géologiques proviennent d'une carte géologique vectorielle intégrée sous forme d'une Feature Collection provenant 
de la carte Géologique de la RDC nous fournit par le Bureau d’étude DRC GREEN-EMEC. Cette base de données contient des 
informations sur les différentes formations lithologiques de la zone d'étude. 

d) Indice de végétation (NDVI) 

Nous avons utilisé le produit MODIS/061/MOD13Q1, qui fournit un indice de végétation normalisé (NDVI) à une résolution 
spatiale de 250 m et une fréquence temporelle de 16 jours. La moyenne des valeurs entre octobre 2022 et septembre 2023 a été 
calculée pour évaluer la couverture végétale [31].  

e) Précipitations (CHIRPS) 

Les données de pluviométrie dans ce travail sont issues de l'ensemble CHIRPS (Climate Hazards Group InfraRed Precipitation 
with Station data) sous la référence UCSB-CHG/CHIRPS/DAILY. 

Ce jeu de données fournit des estimations journalières des précipitations à une résolution de 5 km, permettant d'évaluer les 
tendances de la pluviosité sur la période étudiée [32]. 

f) Texture des sols 

Nous avons utilisé la base OpenLandMap/SOL/SOL_TEXTURE-CLASS_USDA-TT_M/v02, qui fournit des données sur la 
texture des sols classifiée selon les normes de l'USDA. Ces données permettent d'évaluer la capacité de rétention en eau et le degré 
de compacité des sols [33]. 

III.3. Traitement des données 

III.3.1 Préparation des données dans ArcGIS 

a) Délimitation de la Zone d’étude 

La zone d’étude est délimitée dans ArcGIS et exporté en Shapefile qui sera importé dans Google Earth Engine pour délimiter et 
découper les données à y utiliser. 

b) Calcul de la densité de drainage 

La densité de drainage est une mesure qui exprime la longueur totale du réseau hydrographique par unité de surface. Grace au 
MNT SRTM nous avons calculé la densité de drainage dans ArcGIS en utilisant en suivant les étapes ci-après : 

ÉTAPE 1 : PRÉPARATION DES DONNÉES 

1. Télécharger le MNT SRTM 

o Importer le Modèle Numérique de Terrain (MNT) SRTM dans ArcGIS. 

ÉTAPE 2 : GÉNÉRATION DU RÉSEAU HYDROGRAPHIQUE 

2. Calcul du sens d'écoulement (Flow Direction) 

o ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direction. 

o Utiliser le MNT corrigé (résultat de Fill) comme Input surface raster. 

o Sauvegarder la sortie. 

3. Calcul de l’accumulation de flux (Flow Accumulation) 

o ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Accumulation. 
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o Entrer le raster obtenu à l’étape précédente comme Input flow direction raster. 

o La sortie montre les cellules accumulant le ruissellement. 

4. Extraction du réseau hydrographique 

o Utiliser une condition pour extraire les rivières : 

 Raster Calculator (Spatial Analyst Tools > Map Algebra > Raster Calculator). 

o Convertir le raster binaire obtenu en vecteur (rivières) : 

 Conversion Tools > From Raster > Raster to Polyline. 

ÉTAPE 3 : CALCUL DE LA DENSITE DE DRAINAGE 

6. Utilisation de l’outil 'Line Density' 

o ArcToolbox > Spatial Analyst Tools > Density > Line Density. 

o Sélectionner le réseau hydrographique vectorisé comme Input polyline features. 

o Définir la résolution de sortie et le rayon d’analyse selon l’échelle d’étude. 

o Lancer le calcul pour obtenir la carte de densité de drainage. 

ÉTAPE 4 : NORMALISATION ET EXPORTATION 

7. Normalisation 

o Les résultats sont normalisé sur une valeur de 0 à 100 à l’aide des minimum et maximum régionales 

8. Exportation des résultats 

o La carte est exportée pour être utilisé dans Google Earth Engine. 

c) Préparation de la carte géologique à importer dans GEE 

Les couches géologiques présentes dans la zone d’étude sont exportées depuis le shapefile de la carte de géologique de la RDC, 
pour être importé plus tard dans Google Earth Engine. 

III.3.2 Traitement dans Google Earth Engine 

a) Collecte et prétraitement des données 

Le traitement commence par charger et préparer les jeux de données spatiales nécessaires à l'analyse : 

1. Modèle Numérique de Terrain (MNT) : 
o Source : SRTMGL1_003 (USGS) 
o Utilisation : Calcul de la pente, qui influence l'infiltration de l'eau. 

2. Occupation du sol : 
o Source : Dynamic World (Google) 
o Utilisation : Identification des types d’occupation du sol favorables à l’infiltration. 

3. Carte géologique : 
o Importée dans Google Earth Engine depuis ArcGIS 

4. Densité de drainage normalisé :  
o Importé dans Google Earth Engine à partir de ArcGIS 

5. Indice de Végétation (NDVI) : 
o Source : MODIS/061/MOD13Q1 
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o Utilisation : Estimation de la couverture végétale, qui peut influencer l’infiltration et la rétention d’eau. 
6. Pluviométrie : 

o Source : CHIRPS (Climate Hazards Group InfraRed Precipitation with Station Data) 
o Utilisation : Calcul de la somme annuelle des précipitations, un facteur clé pour la recharge en eau souterraine. 

7. Texture des sols : 
o Source : OpenLandMap/SOL/SOL_TEXTURE-CLASS_USDA-TT_M 
o Utilisation : Déterminer la capacité du sol à retenir ou à laisser percoler l’eau. 

b) Normalisation des critères quantitatifs 

Après l’acquisition des données, chaque critère est normalisé pour les ramener sur une échelle commune (0 à 100). 

c) Reclassification des critères qualitatifs 

Certains critères doivent être reclassifiés en fonction de leur influence sur la recharge en eau souterraine : 

 Lithologie : 

Différents types de roches ont des propriétés différentes de perméabilité : 

 Roche imperméable → Faible score 

 Roche poreuse/perméable → Score élevé 

 Occupation du sol : 

Les classes d’occupation sont reclassifiées en fonction de leur influence sur l’infiltration de l’eau. 

Exemples : 

 Forêts → Score élevé (bonne infiltration) 

 Zones urbaines → Score faible (surface imperméable) 

 Texture des sols : 

o Sols sableux/perméables → Haute pondération 

o Sols argileux → Faible pondération 

d) Pondération des critères 

Chaque critère est pondéré selon son importance dans l’évaluation de la recharge en eau souterraine, les pondérations utilisées 
sont celle trouvées en utilisant la Matrice AHP. Chaque critère normalisé est multiplié par sa pondération. 

e) Calcul de la carte finale des zones favorables et Exportation des résultats 

Les critères pondérés sont additionnés pour générer une carte finale des zones favorables : 

 La division par 100 ramène les valeurs dans une plage cohérente. 

 La carte finale est ajoutée à la carte GEE : 

 Chaque critère intermédiaire est aussi affiché pour validation. 

 Et toutes les cartes sont exportées pour visualisation sur ArcGIS : 

III.3.3 Visualisation et Classification dans ArcGIS 

La Classification des résultats en classes de potentiel faibles, modéré, élevé et très élevé est ensuite réalisée dans ArcGIS. 
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IV. RÉSULTATS ET DISCUSSION 

IV.1. Calcul des pondérations 

IV.1.1 Matrice de comparaison 

En se basant sur les études précédentes, voici une estimation plus réaliste des comparaisons entre ces critères. Les valeurs sont 
ajustées pour refléter les observations scientifiques disponibles. Cette matrice est une estimation fondée sur des études de terrain et 
des analyses d'experts dans le domaine de l'hydrologie et des sciences de l'eau. L’explication de cette matrice a été donnée dans les 
généralités et cadre théorique. 

Tableau 1. Matrice de Comparaison AHP utilisée 

Critères 

P
en

te 

O
ccupation d

u Sol 

D
ensité D

rainage 

T
exture du Sol 

G
éologie 

P
luviom

étrie 

N
D

V
I 

Pente 1 2 2 2 3 3 4 

Occupation du Sol 1/2 1 2 2 3 3 4 

Densité Drainage 1/2 1/2 1 2 2 2 3 

Texture du Sol 1/2 1/2 1/2 1 2 2 2 

Géologie 1/3 1/3 1/2 1/2 1 1 2 

Pluviométrie 1/3 1/3 1/2 1/2 1 1 2 

NDVI  1/4 1/4 1/3 1/2 1/2 1/2 1 

IV.1.2 Calcul des pondérations et validation de la cohérence 

a) Pondérations 

Les pondérations finales obtenues à partir de la matrice AHP sont les suivantes : 

Tableau 2. Pondérations utilisées dans cette étude 

Critères Poids (%) 
Pente 27.6 
Occupation du sol 22.6 
Densité de 
drainage 

15.9 

Texture des sols 12.4 
Lithologie 8.1 
Pluviométrie 8.1 
NDVI (végétation) 5.2 

Ces pondérations reflètent l'importance relative de chaque critère en fonction des comparaisons pair-à-pair effectuées dans la 
matrice. 

b) Validation des pondérations 

La « Consistency Ratio » (CR) a été calculée pour valider la cohérence de la matrice AHP. Un CR inférieur à 0,1 indique une 
pondération cohérente et fiable. Le CR trouvé est de 0,02 très inférieur à 0,1 ce qui garantit de la cohérence des pondérations et des 
critères utilisées. 
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Ces critères et pondérations illustrent une approche systématique et scientifiquement rigoureuse pour identifier les zones 
favorables à la recharge et à l’exploitation des eaux souterraines. 

IV.2. Cartes des critères utilisés 

IV.2.1 Géologie 

Pour évaluer la favorabilité à l'infiltration et les zones propices à l'implantation de forages, nous avons attribués des scores aux 
formations Granite, Kibalien, et Roches vertes, en se basant sur des études hydrogéologiques de la région. 

a) Granite (Score : 20/100 ) 

Les granites sont généralement des roches ignées compactes et peu poreuses. Cependant, leur capacité à héberger des aquifères 
dépend des fractures et des altérations. Les zones altérées ou fracturées dans les granites peuvent permettre une certaine infiltration 
et contenir des réserves d'eau, bien que leur capacité soit souvent limitée. Les granites fracturés dans la région de Lubero montrent 
une faible productivité en eau en raison de leur faible porosité primaire, malgré une certaine perméabilité liée aux fractures [34]. 

b) Kibalien (Score : 50/100) 

Le Kibalien, qui regroupe principalement des schistes et des quartzites, présente une perméabilité variable. Les quartzites sont peu 
perméables, mais les schistes fracturés ou altérés permettent une infiltration modérée. Cette formation peut également contenir des 
aquifères discontinus, souvent associés à des failles et des fractures. Le bassin de Beni, des aquifères discontinus ont été identifiés 
dans les schistes fracturés du Kibalien, bien que leur capacité de recharge soit limitée [35]. 

c) Roches vertes (Score : 70/100) 

Les roches vertes, composées principalement de métabasaltes et de métavolcanites, présentent une bonne capacité à héberger des 
aquifères dans les zones altérées ou faiblement métamorphisées. Ces zones offrent souvent une porosité secondaire accrue. Les 
fractures et altérations rendent ces formations plus favorables à l'infiltration et au stockage d'eau. Les métabasaltes altérés dans les 
roches vertes de la région de Butembo sont bien reconnus pour leur rôle dans la recharge des aquifères locaux [36]. 

IV.2.2 Texture des sols 

La zone d’étude est principalement composée d’argile (Clay) avec une petite zone au sud constitué d’argile limoneux (figure 2.b). 
La capacité d'infiltration des sols dépend de leur texture, et il existe des liens directs entre la composition du sol et la vitesse 
d'infiltration. Pour attribuer des poids à notre modèle multicritère, nous avons tenu compte du fait que les sols argileux (Cl) ont un 
poids faible pour l'infiltration (30%), car ils sont moins propices à l'infiltration rapide de l'eau. Les sols argileux-limoneux (ClLo) 
auraient un poids modéré (50%) pour l'infiltration, étant donné que la présence de limon améliore la structure du sol et permet une 
meilleure infiltration que l'argile pure. 
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Figure 2. Carte Géologique (2.a) et de texture du sol (2.b) de la Zone d'étude 

 

IV.2.3 Topographie 

La topographie de cette région est caractérisée par des collines et des montagnes au sud-ouest avec un axe orienté Sud-Ouest -  
Nord-Ouest. Au Nord Est et Nord-Ouest se situe les lieux les moins élevées en altitude.  

Le point le plus élevé dans la zone se situe à 1105 mètres d’altitude et le plus bas à 856 mètres d’altitudes. La médiane des altitudes 
dans la Zone est de 941.8 mètres. 

Deux coupes topographiques  A-B et C-D, respectivement orientées ouest vers sud-est et sud-ouest vers nord-est montrent des 
profils représentées dans la figure 3.d. Ces coupes ont été réalisées grâce au logiciel Surfer. 

La pente varie de 0 à 32 degré dans la région avec une médiane de 5,8 degré. La répartition de la pente est donnée dans la carte 
de la figure 3.b. 
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Figure 3. Topographie de la Zone d'étude : 3.a : carte topographique ; 3.b : Carte des pentes ; 3.c : Topographie 3D ; 3.d : 
Coupes topographiques 

IV.2.4 Autres critères 

L’occupation du sol, la densité de drainage, la pluviométrie et la végétation sont présenté dans la figure 4 ci dessous. 
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Figure 4. Cartes des autres critères. 4.a : Occupation du Sol ; 4.b : Densité de drainage ; 4.c : Précipitations (CHIRPS) ; 4.d : Indice 
de végétation (NDVI) 
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IV.3. Résultats de l’analyse multicritère 

IV.3.1 Présentation de la carte des zones favorables 

L'AHP a été réalisé en intégrant les sept critères pour générer des zones de favorabilité à l’implantation des forages d’eau dans la 
région de Ngoyo-Mununzi. Le résultat final est classé en cinq (5) zones selon la méthode des ruptures naturelles (Natural break) 
(Jenks) dans ArcGIS : très faible, faible, modéré, bon, excellent. 

Le pourcentage de favorabilité varie de 37,49% à 79,86% dans la zone d’étude. Les valeurs de rupture obtenue avec la méthode 
des ruptures naturelles sont 45,97% ; 55,77% ; 60,92 % et 65,90%. Les classes de favorabilité sont donc : 

 Très faible : 37,49% - 45,97% 

 Faible : 45,97% - 55,77% 

 Moyenne : 55,77% - 60,92% 

 Bonne : 60,92% - 65,90% 

 Excellente : 65,90% - 79,86% 

La carte de favorabilité à l’implantation de forage d’eau (Fig. 5) montre un potentiel en eaux souterraines important étant donné 
que les zones de favorabilité bonne à excellente couvrent la majorité de la zone d’étude. Les zones les plus propices à l’implantation 
des forages d’eau dans la zone d'étude sont principalement situées au sud et au nord-ouest. 

Les zones les moins favorables en termes de potentiel en eaux souterraines sont concentrées du centre ouest à l’est.  

IV.3.2 Analyse de la fiabilité des résultats 

Les résultats obtenus à partir de l’approche combinant télédétection et analyse multicritère révèlent que certaines zones de la 
région étudiée présentent un potentiel élevé pour l’implantation de forages. Les facteurs hydrogéologiques intégrés dans le modèle, 
notamment la pente, l’occupation du sol, la densité de drainage, la géologie, la texture du sol, la pluviométrie et la couverture végétale 
ont contribué à une cartographie détaillée des zones favorables. 

L’utilisation du Modèle Numérique de Terrain (MNT) SRTM a permis de dériver des paramètres clés tels que la pente et la 
densité de drainage. Ces paramètres sont essentiels pour estimer la probabilité de recharge des nappes et la faisabilité des forages. 
Une pente modérée à faible est généralement favorable à l’infiltration et limite le ruissellement excessif, ce qui favorise la recharge 
des nappes phréatiques. Dans les résultats obtenus, les zones les plus favorables correspondent justement à ces conditions, validant 
ainsi la pertinence du modèle. 

L’indice de densité de drainage, dérivé du réseau hydrographique, a également joué un rôle important dans la sélection des sites. 
Une densité de drainage modérée indique une recharge potentiellement favorable des nappes par infiltration. Dans les zones où cette 
densité est très faible, le potentiel hydrogéologique est réduit, car l’infiltration est limitée par des formations géologiques peu 
perméables. 

IV.3.3 Comparaison avec d’autres approches et études similaires 

L’analyse comparative avec d’autres études menées en RDC et en Afrique subsaharienne sur l’identification des sites propices 
aux forages montre des similitudes dans les facteurs déterminants. Plusieurs études, citées dans notre revue de littérature, ont 
également démontré que la pente, l’occupation du sol et la densité de drainage sont des variables clés pour l’identification des sites 
favorables aux forages d’eau souterraine. 
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Figure 5. Carte des zones propices à l'implantation des forages 

V. SYNTHÈSE ET RÉCOMMANDATIONS 

V.1. Synthèse des résultats obtenus 

Dans le cadre de cette étude, l’utilisation combinée de la télédétection et de l’analyse multicritère a permis de réaliser une 
identification préliminaire des sites les plus propices à la mise en place de forages d’eau potable dans la région de Ngoyo - Mununzi, 
au Nord-Kivu, en République Démocratique du Congo. À travers l’exploitation de différents critères géospatiaux : la pente, 
l’occupation du sol, la densité de drainage, la géologie, la texture du sol, la pluviométrie et la couverture végétale, plusieurs 
conclusions majeures ont pu être tirées. 

Premièrement, la pente a montré une influence déterminante sur la distribution des ressources en eau, les zones de faible pente 
étant généralement les plus adaptées pour l’installation de forages, en raison de leur meilleure capacité de collecte d'eau. L’analyse 
de l’occupation du sol a mis en évidence que les zones agricoles et les zones boisées sont des secteurs privilégiés pour l’implantation 
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de forages, ces espaces étant moins susceptibles d’être impactés par des activités industrielles ou urbaines à forte consommation 
d’eau. 

Quant à la densité de drainage, Une densité de drainage modérée indique une recharge potentiellement favorable des nappes par 
infiltration. Dans les zones où cette densité est très faible, le potentiel hydrogéologique est réduit, car l’infiltration est limitée par des 
formations géologiques peu perméables. La géologie, quant à elle, a montré que les terrains constitués de formations géologiques 
perméables, sont les plus propices à l’infiltration et à la rétention d’eau. La texture du sol, qui fait référence à la proportion de sable, 
limon et argile, a également été un critère crucial, les sols argileux étant moins aptes à permettre une infiltration rapide de l’eau. 

L’analyse de la pluviométrie a permis de constater que la variation des précipitations est négligeable dans la région. Enfin, la 
couverture végétale a permis de déterminer les zones les moins exposées aux risques d’évaporation excessive, facilitant ainsi la 
conservation des ressources en eau souterraine. 

L'intégration de ces critères à l’aide de la télédétection a facilité l'élaboration d’un modèle de prédiction des zones les plus 
favorables à l'implantation de forages. Cette approche multicritère a non seulement permis d’optimiser le choix des sites, mais a 
également amélioré la précision des décisions en matière de gestion des ressources en eau, en tenant compte des spécificités 
environnementales de la région de Ngoyo - Mununzi. 

V.2. Recommandations pour la mise en place de forages 

Sur la base des résultats obtenus, plusieurs recommandations peuvent être formulées pour la mise en place de forages d’eau 
potable dans la région de Ngoyo - Mununzi. 

V.2.1 Zones prioritaires pour l’installation de forages 

Les sites les plus appropriés pour l'implantation de forages se trouvent principalement dans les zones présentant une faible pente, 
une densité de drainage modérée et une géologie favorable. Ces zones devraient être prioritaires pour les études de faisabilité 
approfondies, en raison de leur potentiel de recharge rapide et de durabilité des nappes phréatiques. De plus, les zones agricoles et 
les zones boisées à forte pluviométrie sont également des candidats idéaux, car elles bénéficient d’une recharge continue en eau grâce 
aux précipitations. 

V.2.2 Stratégies d’optimisation de la gestion des ressources en eau 

Afin de garantir la durabilité et l'efficacité des forages, il est recommandé de suivre une approche intégrée de gestion des 
ressources en eau. Cela inclut l'élaboration d'un plan de gestion de l'eau qui tienne compte de la variabilité saisonnière de la 
pluviométrie et des besoins en eau des communautés locales. Des efforts doivent être déployés pour encourager la conservation de 
l’eau dans les zones où la végétation est dense, afin de réduire les risques d’évaporation et d’optimiser la recharge des nappes 
phréatiques. 

En outre, une surveillance continue des sites de forage doit être mise en place pour évaluer la stabilité des nappes phréatiques et 
ajuster les stratégies de gestion en fonction des fluctuations de la demande en eau. Des mesures de protection des zones critiques, 
telles que des forages protégés par des périmètres de sécurité autour des sources, doivent être considérées afin de limiter les risques 
de contamination. 

Enfin, pour renforcer la durabilité du système, il est recommandé de favoriser des techniques de forage et de pompage adaptées 
aux spécificités locales, en mettant l’accent sur l’utilisation de technologies peu coûteuses et faciles à entretenir pour les populations 
rurales. Une formation des communautés locales à l'entretien des infrastructures d’eau potable et à la gestion des ressources en eau 
serait également bénéfique pour assurer la pérennité des forages. 

V.3. Limites et contraintes de l’étude 

Bien que la méthodologie adoptée ait permis une cartographie pertinente des sites potentiels, certaines limites doivent être 
soulignées : 
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 Résolution des données : L’utilisation du MNT SRTM (30 m de résolution), bien que courante en hydrogéologie, peut 
introduire des incertitudes dans la détection fine des variations topographiques locales. Une résolution plus fine, issue 
de levés LiDAR ou de drones, pourrait améliorer la précision des résultats. 

 Données hydrogéologiques locales : Le modèle n’intègre pas directement des données précises sur la conductivité 
hydraulique des formations géologiques locales ni sur les débits réels des nappes. L’intégration de données issues de 
campagnes de forages et de tests de pompage améliorerait la fiabilité de la sélection des sites. 

 Facteurs anthropiques : L’occupation du sol et l’exploitation des ressources en eau par les populations locales peuvent 
influencer la recharge et la qualité de l’eau souterraine. Une analyse socio-économique approfondie pourrait enrichir 
l’approche en intégrant des considérations liées à l’accessibilité et à la durabilité des forages. 

VI. CONCLUSION 

L’objectif principal de cette étude était d’identifier préliminairement les sites propices à la mise en place de forages d’eau potable 
dans la région de Ngoyo - Mununzi, au Nord-Kivu, en République Démocratique du Congo, en utilisant une approche basée sur la 
télédétection et l’analyse multicritère. L’application de critères géospatiaux tels que la pente, l’occupation du sol, la densité de 
drainage, la géologie, la texture du sol, la pluviométrie et la couverture végétale a permis d’élaborer un modèle intégré facilitant 
l’identification des zones les plus adaptées à l’exploitation des ressources en eau souterraine. 

Les résultats ont montré que les zones présentant une faible pente, une géologie favorable (formées de roches perméables), une 
densité de drainage modérée, ainsi qu’une couverture végétale modérée sont les plus propices à l’installation de forages d’eau potable. 
Ces résultats soulignent l’efficacité de la télédétection et de l’analyse multicritère dans la gestion des ressources en eau, en permettant 
une évaluation précise et rapide des zones les plus adaptées à l'implantation d'infrastructures hydrauliques. 
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